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. . . In the News

Attendees at the 2003 CHMM Conference

Two of our chapter members, John Murray and Elsa Payne attended this year’s annual Conference in Dallas, Texas.  Elsa was our Chapter Delegate.

John has provided us with the following highlights: 

· This year's conference was a success. 

· The presentations that he attended were well prepared and given. The poster session, included our own Elsa Payne (see article below) was also well done.  

· The biggest thing that was being pushed this year was the definition of "environmental professional".  The BOD wanted everyone to sign one of those forms before they left in support of the Academy’s position of what is an “environmental professional”.  

· The increase in dues announced at the 2002 conference has put the Academy back in the black by about $75K. 

· Doye Cox was given the Pete Cook Founders Award for long term services to the Academy. Doye is the editor of the Desk Reference. 




· Next year's conference will be August 1-4 in Las Vegas.  2005 will be in St. Louis MO and 2006 in Orlando. There are no dates yet for the latter two sites. 

· The NJ Chapter was recognized for having the CHMM accepted along with NJs version of the LEP/LSP. 

· National is also pushing for the Chapters to offer review classes based on National’s Overview Course (NOC). 

· Call for papers is out for the 2004 Conference in Las Vegas.  Deadline is January 16, 2004. 




GOVERNMENT AFFAIRS

National Issues

Review of Environment Rules Finds Benefits Outweigh Costs
September 28, 2003
By JOHN H. CUSHMAN Jr. (New York Times) 


WASHINGTON, Sept. 27 - The White House office in charge of reviewing federal regulations has reported that the benefits of some major environmental rules appear to exceed the costs by several times and that the net benefits may be even larger than previously acknowledged. 

In its annual review of the costs and benefits of
regulations, the Office of Management and Budget examined a sampling of major rules and found that the total benefits, to the extent they can be measured, were at least triple the costs. 

In this report, which was described on Saturday in The
Washington Post, the Environmental Protection Agency was found to have produced significantly greater net benefits than last year's report acknowledged. But the change was mainly due to accounting technicalities. 

In one change, the budget office expanded its review by looking back 10 years. This meant the latest report
included the effects of the successful efforts of the
1990's to rein in the pollution that causes acid rain. 

The report included only a handful of the 4,135 final rules published in the Federal Register during the fiscal year that ended on Sept. 30, 2002. Its principal focus was on three rules issued by the Energy Department, the Transportation Department and the EPA They imposed estimated annual costs of $1.6 billion to $2 billion, but produced estimated annual benefits of $2.4 billion to $6.5 billion. 



New Web site teaches teens about the environment
September 29, 2003

The U.S. Environmental Protection Agency today unveiled a new Web site to help high school students explore and learn about their environment and ways to protect it. The site can be found at www.epa.gov/highschool/.

"For all the students going back to school, this will be an especially valuable environmental information resource," said EPA Acting Administrator Marianne Lamont Horinko. "It can sometimes be difficult to know what to trust on the Web, but like all EPA materials, this site has been thoroughly reviewed to make sure it's accurate and educational."  

A team of EPA environmental educators created the new Web site to help high school students find good environmental information, not just on EPA's Web site, but on other reliable sites as well. The team used guidelines developed by the North American Association for Environmental Education to ensure that only truly educational materials were included.  The site complements other EPA sites for kids and teachers.

The Web site contains easy to find and easy to understand information about air and water issues, waste and recycling, conservation, health and safety, ecosystems, and community environmental conditions. It also links interested students to internship and scholarship opportunities, environmental careers and community involvement projects.



US DOT Regulations

HM –232: Requires that all registered shippers and transporters of hazardous materials have a written security plan in place by September 25, 2003.  They are also required to have hazmat training in place by December 22, 2003.

HM 215E: Final rule became effective October 1, 2003.  Mandatory compliance of hazmat regulations to coincide with international shipping and handling regulations by October 1, 2004.

State Issues

New York Proposes Stricter Standard for MTBE in Water

The New York state Department of Health has proposed lowering the permissible amount of the gasoline additive methyl-tertiary-butyl-ether in public water.

MTBE is covered by the current state limit for "unspecified organic contaminants," which is at 0.050 milligrams per liter. The proposed standard calls for a limit of 0.010 mg/L in water supplies.  The limit, proposed last week, is subject to a 45-day.
 


Connecticut Increases Permit Fees

Effective August 21, 2003, most fees required pursuant to Title 22a of the Connecticut General Statutes, and regulations adopted thereunder, have been increased in accordance with the newly adopted budget. Since
the changes were effective upon passage, available application packages may not reflect these increases. In the meantime, if you have any questions regarding applicable fees, please contact the appropriate
permit program or call the Permit Assistance Office at 860-424-3003.


Comment period.




Board of Directors for 2003
President

Paul Simonetta, CHMM

Triton Environmental, Inc.

741 Boston Post Rd. Suite 101

Guilford, CT  06437

(860) 458-7200

Vice President 
Susan Katz, CHMM

Pratt & Whitney

400 Main St. m/s 169-16

East Hartford, CT 06108

(860) 565-7146
Secretary

Heather Galarneau, CHMM

heathergalarneau@yahoo.com
Treasurer

Rosemary Coggeshall, CHMM, CSP

jimcog@earthlink.net
(860) 848-4140
Past President

Dominick Zackeo, CHMM

GZA GEO Environmental

27 Naek Rd

Vernon, CT 06066

(860) 875-7655

Membership Chairman

John Murray, CHMM, CSP, CIH

Baystate Health Systems

759 Chestnut Street, 
Safety Office  P5901

Springfield, MA 01199

(413) 794-5494

Government Affairs Chairman

Matthew Twerdy, CHMM

Fuss & O’Neill, Inc.

146 Hartford Rd.

Manchester, CT 06040

(860) 646-2469, ext. 5534
Look What’s New . . . 





The CT Chapter of the ACHMM is proud to unveil its newly designed logo.  Future issues of our newsletter will feature the new logo.


The logo is available for use by fellow chapter members.   Please contact John Murray (�HYPERLINK "mailto:John.Murray@bhs.org"��John.Murray@bhs.org� or (413) 794-5494) to obtain a copy via e-mail or CD.


Our thanks to John for his efforts in designing the logo!







































































Earning Your Annual CMP’s*


It’s That Time of Year 





There are now a number of various sources that provide alternatives for those who cannot attend conventional seminars and conferences in order to obtain the required 20 hours of annual training.  For example:


Government Institutes in Rockville, Maryland offers quite a few self-study courses that qualify for IHMM-approved CMP’s.  Check out their website for course and CMP information. � HYPERLINK http://www.govinst.com/distancelearning.html ��www.govinst.com/distancelearning.html�


American Industrial Hygiene Association offers web-based courses and self-study workbook courses that award CM/CEU’s when completed.  Check out their website at � HYPERLINK http://www.aiha.org/DistanceLearning/html/webcourses.html ��http://www.aiha.org/DistanceLearning/distancehome.htm�


.








*For requirement details, visit IHMM at � HYPERLINK http://www.ihmm.org ��www.ihmm.org�.


















































Picture Caption - Use this style to type a description of a picture or illustration.


Subtitle - Use this style to type sub-headings in an article.


Use PullQuote to excerpt text from the main text of a story to draw a reader’s attention to the page. See page 4 for an example.
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President’s Message





The Academy of Certified Hazardous Materials Managers recently held their annual national conference in Dallas, Texas.  John Murray and Elsa Payne were in attendance at the conference and provided an update to the Connecticut ACHMM Chapter during our most recent Board of Directors meeting.  Based on their input, we believe that the national conference continues to be a great way for CHMMs to interact with the organization at the national level.  Having attended the previous two years, I found that there are informative technical sessions as well as respectable keynote speakers.  A special thanks to Elsa for representing us as the local chapter delegate.  In addition to participating in the group meeting for chapter delegates, Elsa presented a poster board session during the technical portion of the conference.  We hope to hear more from Elsa and John about their experiences at the conference during our next meetings.


As reported to the Board of Directors, a topic of considerable interest at the conference was the definition for an "environmental professional" that is being considered by the EPA regarding certification on the clean up of contaminated sites.  By this time, the definition should have been distributed to our group via e-mail.  We are continuing to discuss this amongst the group to decide whether a response to the EPA is appropriate.


The Connecticut DEP (the DEP) has finalized the General Permit for the Discharge of Stormwater Associated with Industrial Activity (issued October 1, 2002 and modified July 15, 2003).  As many of you probably know, the CHMM certification has been included in the general permit such that a CHMM can now complete the certification for the Stormwater Pollution Prevention Plan (SWP3) as well as the Non-Stormwater Certification statement.  Several other changes have been included with the modified general permit.  As such, it is recommended that all CHMMs review the permit as well as the associated guidance documents prior to completing any certification activities.


We are planning our final general membership meeting in 2003 to be scheduled for November.  The meeting will be held at the Yankee Silversmith in Wallingford, CT.  A number of topics have been discussed for this end of the year meeting.  More details regarding this meeting will be provided within the next several weeks.  I hope that everyone can attend and I look forward to seeing you all there.





Sincerely,





Paul Simonetta, CHMM


 

















Call for Nominations for Board of Directors


Open Position for 2004





The CT Chapter of ACHMM will have open the position of Vice President (President Elect) for 2004.  Any CT ACHMM member in good standing is encouraged to run.  Watch your mail for nomination ballots.  Election will take place in November.






































The Vice President (President-Elect) is elected to serve one year and expected to serve as President the following year; this position presides over chapter meetings in the absence of the President and ensures the development and execution of an appropriate annual educational program for the chapter.























in the text box where you want the text to flow. (When you move the upright pitcher over a text box that can receive the link, the pitcher turns into a pouring pitcher.)


Repeat these steps to create links to additional text boxes.


In the first text box, type text that you want. As the text box fills, the text will flow into the other text boxes that you’ve linked. 


Formatting Text Boxes


You can change the look of linked text boxes by using color, shading, borders, and other formatting. Select the text box you want to format and then double click its border to open the Format Text Box dialog box. If you want to change the color or borders on a text box, choose the Colors and Lines tab. To change the size, scale, or rotation, click the Size tab. To change the position of the text box on the page, click the Position Tab.  If you have other text surrounding the text box, and want to change the way the text wraps around it, click the Wrapping tab. If you want to format all the text boxes in an article, you must format them individually - the formatting on one text box will not apply to the others in the sequence. 


Using Linked Text for Parallel Articles


You can use linked text boxes to flow text in parallel  “columns” from page to page. This method gives different results than using the Column command on the Format menu, which causes text in column 1 to flow or “snake” to column 2 on the same page. By using linked text boxes, you can instead have text from column 1 flow to column 1 on the next page. The text beside it in column 2 can flow to column 2 on the next page, parallel to column 1. This technique is useful if you need to group two similar articles, for instance, an article translated in English on the left and the same article translated in French on the right. 


To flow text in parallel, display paragraph marks in your document. Click at the top of the page where you want the side-by-side columns to start, and press Enter twice. Click in the first paragraph mark on the page. On the Insert menu, click Text Box and drag on the page where you want the first column. Click Text Box again and then click and drag where you want the second column. Click in the last paragraph mark on the page, and press Ctrl + Enter to create a page break.


Repeat the process for each page that will contain side-by-side columns in your document and then return to the first text box you created. Click the text box on the left once to select it. Click your right mouse button and then click Create Text Box Link. The pointer becomes a pitcher. Click the text box on the left side of the second page to create a link. Create links for all text boxes within the same article on the left side of the document. Repeat the process for every text box in the right chain or article.


Pressing Enter twice at the top of each page will create an extra empty paragraph. This blank paragraph is useful if you want to insert text or graphics outside of the text boxes. You can delete the extra blank paragraph if you don't need it.


Copying linked text boxes


You can copy an article or a chain of text boxes that are linked together, to another document or to another location in the same document. To copy linked text boxes and the text they contain, you must copy all the linked text boxes in an article. Select the first text box in an article. Hold down Shift, and click each additional text boxes you want to copy. On the Edit menu, click Copy. Click where you want to copy the text boxes and then click Paste.


To copy some of the text from  an article, select the text you want to copy from the article and then copy it. Do not select the text box. You can paste text you’ve copied directly into your document, into another location within the same article, or into another article.


Notes on Linked Text Boxes


The text boxes that you link to must be empty—they cannot contain text.


Linked text boxes must be contained in a single document. You cannot create text box links from one subdocument within a master document to another subdocument. You also cannot split subdocuments that contain linked text boxes belonging to the same article.


If you click Create Text Box Link and then decide you don’t want to link to another text box, press Esc to cancel.


To move between text boxes in an article, select one of the text boxes and then click either the Next Text Box or Previous Text Box on the Text Box Toolbar. (
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Calendar of Events


CONSTRUCTION SAFETY LEADERSHIP SYMPOSIUM


New Orleans, LA


Oct 16-17, 2003


“Find out what works “ in reducing occupational safety and health losses in construction. For more information, visit � HYPERLINK http://www.asse.org ��www.asse.org�.


CERTIFICATE IN ENVIRONMENTAL, HEALTH & SAFETY


chicago, IL


October 13-17, 2003


Comprehensive seminar covering important environmental, health and safety law issues.  For more information, visit � HYPERLINK http://www.IAML.com ��www.IAML.com�.


COMPLETE ENVIRONMENTAL REGULATIONS WORKSHOP 


Hartford, CT


October 27-28, 2003


Visit the website at � HYPERLINK http://www.lion.com ��www.lion.com� for additional courses and locations. 


MOLD REMEDIATION


Orlando, FL


November 3-5, 2003


Presented by ACGIH and the ACGIH Bioaerosols Committee.  For further information, visit � HYPERLINK http://www.acgih.org ��www.acgih.org�.


LAW SYMPOSIUM FOR THE SAFETY, HEALTH AND ENVIRONMENTAL PROFESSIONAL


Ft. Lauderdale, FL


November 20-21, 2003


Learn how to prevent lawsuits or how to mitigate the impact of a liability loss.  For more information, visit � HYPERLINK http://www.asse.org ��www.asse.org�.


 ASSE REGION VIII 2003 PDC


Mystic, CT


December 2-3, 2003


For more information, visit � HYPERLINK http://www.newenglandasse.homestead.com/ProfessionalDevelopmentConferenc.html ��www.newenglandasse.homestead.com/ProfessionalDevelopmentConferenc.html�.








 






































November Elections





General membership will be voting on Thursday, November  20, 2003 on the following:








Nominees for vice president for 2004; paper ballots will be arriving in the mail shortly.





Revision of the chapter by-laws.  The current by-laws can be viewed on the chapter website at � HYPERLINK http://www.ctachmm.org ��www.ctachmm.org�.











Thanks TO THOSE who contributed to this newsletter:





John Murray


Elsa Payne


Paul Simonetta


Matt Twerdy 








---- Rose Coggeshall


Editor





�





�





Elsa Payne from the USDA, a CT Chapter member, presented a poster in conjunction with Steve Maloney and Jon De’Ath of Entech, Inc.entitled “A Field Investigation into Possible Causes of Unusually High Acetone Levels in Soils”.  Their hypothesis was that acetone would only be detected in the sodium bisulfate preserved samples of method SW 5035.  Concentrations of acetone would increase the longer the preservative was in contact with the soil matrix. Acetone would not be detected, or at significantly lower concentrations, in the 4-oz unpreserved jar samples.








�





�


Congratulations to John Murray, with Pete Cook for receiving the Champion of Excellence Award presented to him at the National Conference in Dallas!





Come One, Come All . . . 





JOIN US AT THE YANKEE SILVERSMITH





General Membership Meeting








Join us for dinner, socialization, guest speakers and a raffle!





Date:	Thurs. November 20, 2003


Time:	5:30 PM





The Yankee Silversmith Inn is located in Wallingford, CT.  Call (203) 269-5444 or visit their website for directions at � HYPERLINK http://www.yankeesilversmith.com ��www.yankeesilversmith.com�.





Watch your e-mail for more information!
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Membership Desk





Call to CHMM’s:


I'm looking for current e-mail addresses for CT Chapter members Dick Gunnell and Steve Nowakowski. If anyone has contact with either of these members, please have them contact me at �HYPERLINK "mailto:john.murray@bhs.org"��john.murray@bhs.org� or 413-794-5494. 


Also, according to our last update, 47 of 103 registered Connecticut CHMMs have signed up as Connecticut chapter member when paying their annual membership fees to National. Please remember to check this box at your next renewal. 


For Non-Members: 


The Connecticut Chapter is developing a database of contact information of non-CHMMs who we would like to keep abreast of Chapter activities through direct e-mail or the newsletter.  If you have anyone that you would like to add; business contacts, consultants, etc., please send me a name and e-mail address.  This will be an electronic distribution to avoid postage costs, so the e-mail is important 


Thanks,


John Murray, CHMM, CSP, CIH


Membership Chair








�





OCTOBER is . . . 





CHILD SAFETY MONTH.  CHECK OUT THIS INFORMATION WEBSITE:


�HYPERLINK "http://www.childrenshealth.gov/calendar.html"��http://www.childrenshealth.gov/calendar.html�








BREAST CANCER AWARENESS MONTH.


HERE ARE SOME INFORMATIVE WEBSITES.


� HYPERLINK http://www.nbcam.org/ ��www.nbcam.org�


� HYPERLINK http://www.cancer.org ��www.cancer.org�


www.komen.org
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